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ABSTRACT 

 

 

Kim, Seung Joon. M.S.B.M.E., Purdue University, August 2012. Effects of Collagen Gel 

Stiffness on Cdc42 Activities of Endothelial Colony Forming Cells during Early Vacuole 

Formation. Major Professor: Dr. Sungsoo Na. 

 

 

Recent preclinical reports have provided evidence that endothelial colony 

forming cells (ECFCs), a subset of endothelial progenitor cells, significantly improve 

vessel formation, largely due to their robust vasculogenic potential. While it has been 

known that the Rho family GTPase Cdc42 is involved in this ECFC-driven vessel 

formation process, the effect of extracellular matrix (ECM) stiffness on its activity during 

vessel formation is largely unknown. Using a fluorescence resonance energy transfer 

(FRET)-based Cdc42 biosensor, we examined the spatio-temporal activity of Cdc42 of 

ECFCs in three-dimensional (3D) collagen matrices with varying stiffness. The result 

revealed that ECFCs exhibited an increase in Cdc42 activity in a soft (150 Pa) matrix, 

while they were much less responsive in a rigid (1 kPa) matrix. In both soft and rigid 

matrices, Cdc42 was highly activated near vacuoles. However, its activity is higher in a 

soft matrix than that in a rigid matrix. The observed Cdc42 activity was closely 

associated with vacuole formation. Soft matrices induced higher Cdc42 activity and faster 

vacuole formation than rigid matrices. However, vacuole area is not dependent on the 

stiffness of matrices. Time courses of Cdc42 activity and vacuole formation data revealed 

that Cdc42 activity proceeds vacuole formation. Collectively, these results suggest that 

matrix stiffness is critical in regulating Cdc42 activity in ECFCs and its activation is an 

important step in early vacuole formation.   
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1. INTRODUCTION 

 

 

The vascular system provides nutrients and hormones and exchanges gases and 

the waste of cells to maintain homeostasis and respond in pathological conditions [1, 2]. 

Two essential mechanisms are involved in the formation of blood vessels: angiogenesis 

and vasculogenesis. Angiogenesis is the sprouting and growth of new capillaries from 

pre-existing vessels, whereas vasculogenesis is de novo formation of primitive vascular 

networks by the differentiation of endothelial precursor cells into endothelial cells (ECs) 

[2, 3]. Two processes allow the development of tissues over the diffusion limit of 100-200 

μm [4, 5]. New capillaries, lined by endothelium, start to form where vascularization is 

needed to regenerate tissue and maintain homeostasis [6]. The remodeling of blood 

vessels continues when quiescent ECs are stimulated by cytokines so that the cells start to 

migrate, proliferate, differentiate, form lumens and lead to blood vessel stabilization in a 

sequence. During the remodeling process, vacuoles are formed inside the cytoplasm of 

the individual cells and then coalesce to form lumens (Fig. 1.1) [7, 8]. Vascularization is 

especially critical in both the progress of cancer and tissue engineering. Dr. Folkman has 

demonstrated that metastasis is dependent upon angiogenesis [9]. In addition, tissue 

engineering has still shown only limited success due to avascular structures which limit 

the diffusion of oxygen and nutrients to develop functional tissues [5]. Hence, 

understanding the molecular mechanisms that govern vascularization will provide the 

insight for therapeutic potentials for cancer, vascular diseases and the development of 

vascular tissue grafts.  
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Figure 1.1 Morphogenetic steps of the remodeling blood vessels [8] 

 

 

1.1 Endothelial Progenitor Cells in Vasculogenesis 

To form a vascular network within scaffolds for therapeutic applications, 

implanted cells have to show both high proliferative ability and blood vessel forming 

ability. Various types of cells have been utilized to investigate in vitro capillary 

morphogenesis. Although human umbilical vein endothelial cells (HUVECs) have been 

shown to promote vasculogenesis and angiogenesis, they have showed limited capacity 

for proliferation [10-12]. 

 

Recently, endothelial progenitor cells (EPCs) have been identified as being 

released from bone marrow, circulate in the blood vessels and home to sites where vessel 

formation is needed [13]. The therapeutic potential of EPCs has already been shown to be 

quite promising for treatments. Therapeutic improvement has been shown as a cell 

therapy, as bioengineered grafts, a gene delivery and a clinical application [14]. Unlike 

mature ECs, EPCs have shown to improve neovascularization (Fig. 1.2) [15]. Although 

EPCs showed positive results in some clinical trials, their results were inconsistent. This 

is due to lack of specific markers to identify the EPCs, various isolation methods and the 

rarity of the cells [16-18]. 

 

Identification of putative EPCs has been based on surface markers of 

hematopoietic stem cells (HSCs) and ECs, such as CD34, CD133 and VEGFR2, von 

Willebrand factor (vWF), CD31, CD144 and C-X-C chemokine receptor type 4 (CXCR4). 
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While both hematopoietic and endothelial markers have been utilized to identify putative 

EPCs, the ambiguity of specific EPC markers has led to a difficulty in identification of 

putative EPC. There are two problems in isolation methods regarding the ambiguity of 

the EPC markers. EPCs may differentiate into mature ECs. Additionally, other cell 

populations such as hematopoietic stem cells, mature monocytes, dendritic cells and B 

lymphoid cells make it hard to discriminate putative EPC [19, 20]. Thus, developing 

specific makers for defining putative EPC is crucial to distinguish them from other 

subsets.  

 

Regarding isolation methods, Asahara et al. first described the existence of EPCs [21]. 

Their report showed that peripheral blood mononuclear cells (MNCs) can be 

differentiated into mature ECs as well as putative EPCs, named as circulating angiogenic 

cells (CACs). These cells can incorporate into sites of neovascularization in animal 

models [22]. The isolated cells indicated as CACs showed the ability to uptake acetylated 

low–density lipoprotein (Ac-LDL) and bind ulex europaeus agglutinin 1 (UEA-1) [21, 

22]. Additionally, CACs express cell surface markers such as CD31, CD144, vWF and 

kinase insert domain receptor (KDR) [22, 23]. However, this method has a critical defect 

because platelets putative EPCs. Thus, method is considered as an unreliable method to  

 

 

 

Figure 1.2 Schematic diagram of EPC homing and incorporation into tissue 
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contaminate MNCs so that platelet membrane proteins transfer to adherent this isolate 

putative EPCs [24]. 

 

The CACs isolating method has been modified by Hill et al. and referred to as  

colony-forming unit-Hill (CFU-Hill) [16]. CFU-Hill cells express same cell surface 

markers of CACs and show the ability to uptake Ac-LDL. CFU-Hill cells also express 

monocyte/macrophage cell surface markers such as CD14, CD45, and CD115. 

Furthermore, the cells ingested bacteria and displayed nonspecific esterase activity [23]. 

Although CFU-Hill cells contribute to neoangiogenesis, they are regarded as colonies of 

hematopoietic cells due to the lack of endothelial specificity [25].  

 

The last isolating method is endothelial colony-forming cells (ECFCs) [18], 

which are also referred to as blood outgrowth endothelial cells (BOECs) [26]. ECFCs 

express CD31, CD105, CD144, CD146, vWF, and KDR as well as uptake Ac-LDL. 

Unlike CFU-Hill cells, ECFCs did not express hematopoietic/macrophage cell surface 

markers [25]. In addition, they demonstrated high telomerase activity and proliferative 

potential [18]. No other types of EPC have spontaneously formed the vasculature in vivo. 

Only ECFCs have a capacity to form a de novo vasculature in vivo and they have been 

speculated as an EPC [27]. Further analysis of specific markers and the functional vessel 

forming ability of EPC is needed to utilize the cell as a source of angiogenesis in a 

clinical application. 

 

 

1.2 Matrices for in vitro Vasculogenesis 

To build a bioengineered graft, a scaffold is necessary to provide suitable 

microenvironments for vascularization. A scaffold supports cell survival as well as 

cellular functions such as migration, differentiation and morphogenesis [28]. There are 

two types of polymers applied to a vasculature by ECs: synthetic- and nature-derived 

polymer. Synthetic matrices such as polyethylene glycol (PEG) [29] and poly (lactide-co-

glycolide) (PLGA) [30] have been used to study endothelial capillary network formation. 
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Synthetic polymer matrices are appealing because they are controllable and reproducible. 

Most of synthetic polymers, however, can elicit the immune response [31] and degraded 

polymers can acidify the microenvironments which inhibit angiogenesis [32].  

 

Natural-derived biopolymer matrices such as collagen, fibrin, matrigel, elastin, 

hyaluronic acid, dextran, fibronectin and algnitate also have been studied in angiogenesis 

and vasculogenesis [13, 33-35]. The advantages of natural-derived biopolymer matrices 

are that they are bio-compatible, enzymatically degradable and their interaction with cells 

promotes vascularization [36]. The drawbacks of using natural-derived biopolymers are 

infection by pathogens, source and batch variation, and complicated systematic 

investigations of the matrix stiffness and biochemical signals which cannot be 

independently examined [37].   

 

Specifically, collagen type I has been known to provoke vascular network 

formation of ECs. A substantial body of evidence has been provided that the interaction 

between collagens and ECs is relevant in capillary morphogenesis [28]. Also, collagen is 

highly occupied in tissues and showed the greatest mechanical integrity and broad range 

of mechanical properties [38, 39]. EC tubular morphogenesis is divided into cord 

formation and vascular lumen formation which depend on the culture types of a collagen 

gel. ECs form capillary-like cords in a 2-dimensional (2D) and 3-dimensional (3D) 

interstitial collagen gel, whereas cells form intracellular vacuoles and lumens in a 

suspension of a 3D collagen gel (Fig. 1.3) [40].  

 

 

1.2.1 2D Scaffolds 

A confluent monolayer of ECs with collagen [28], fibronectin [41] and fibrin [42] 

has been shown to form an interconnecting network of vascular cords. Collagen type I 

especially promotes vascular cord formation in a 2D and 3D interstitial gel. The 

mechanisms of how collagen type I supports cord-like structures have been identified. 

Collagen type I binds to α1β1 and α2β1 integrins and suppresses promotes cord 
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formation. On the other hand, the elevation of cAMP inhibits cord formation by ECs. In 

addition, Src kinase and Rho GTPase are involved in capillary cord formation via β1 

integrin. While activation of Src inhibits VE-cadherin to form actin stress fibers, 

inhibitors of Src and Rho suppress actin stress fiber induction so that capillary cord 

formation is disturbed [28]. These results suggest that actin stress fibers and contractility 

are critical in angiogenesis.  

 

 

1.2.2 3D Scaffolds 

EC tube morphogenesis has been investigated by a 3D gel which induces 

vacuoles and lumens. In a suspension of a 3D gel, including collagen, hyaluronic acid 

and fibrin, ECs tend to form intracellular vacuoles and lumens [28]. In a collagen gel, 

lumen formation is dependent on pinocytic intracellular vacuoles. These vacuoles 

coalesce with each other and form lumens [43]. Membrane type-matrix metalloproteinase 

(MT-MMP), Cdc42 and Rac1 are known to be required for vacuole and lumen formation. 

However, RhoA is not involved in the lumen formation in a 3D collagen model [44]. 

These results indicate cord formation and lumen formation by ECs depend on the 

distinctive matrix-integrin-cytoskeleton signaling pathway [28, 40]. 

 

 

 

Figure 1.3 ECs in 2D culture form cord-like structure whereas ECs in 3D culture generate 

lumens [40] 
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1.3 Matrix Stiffness and in vitro Vasculogenesis 

It has been well established that cells interact with microenvironments via focal 

adhesions. Focal adhesions are large molecular complexes that are composed of integrin 

receptors and multiple proteins including talin, vinculin and paxillin [45]. Mechanical 

cues from ECM are transmitted through focal adhesions to regulate cellular behaviors 

such as shape, migration, proliferation and differentiation [46]. The critical role of 

mechanical cues in cellular behaviors has been well revealed by stem cell studies. Ruiz et 

al. and Engler et al. have demonstrated that mechanical cues can control mesenchymal 

stem cell (MSC) lineage commitment [47, 48]. MSCs under high force differentiate into 

osteogenic lineage while the cells under low force differentiate into adiopogenic lineage 

[47]. In addition, MSCs in a soft matrix differentiate into neuronal lineage, whereas 

matrices with intermediate and rigid stiffness induce muscular and osteogenic lineage, 

respectively [48]. Similarly, neural stem cells (NSCs) differentiate into neuronal lineage 

in a soft gel, but differentiate into glial lineage in a rigid gel [49]. Although the 

importance of mechanical cues from ECM and cellular behaviors has been verified with 

various types of evidence, capillary morphogenesis of ECs under mechanical properties 

of scaffolds has not been well understood.  

 

 

1.3.1 Mechanical Properties of a 2D Gel in Vasculogenesis 

The effect of ECM stiffness on vascular cord formation has been extensively 

studied [42, 50-52]. Califano et al. have provided the evidence that vascular cord 

formation is dependent on substrate mechanics [50]. Bovine aortic endothelial cells 

(BAECs) were cultured on various mechanical properties of substrates with type I 

collagen. Cord formation preferred a compliant substrate rather than a stiffer substrate. 

Despite of a stiffer substrate, the reduced density of collagen enabled the cells to form 

vascular cord. In addition, fibronectin was necessary to stabilize cell and cell contact and 

induce cord formation regardless of substrate stiffness [50]. Stѐphanou et al. have 

demonstrated HUVECs on different concentrations of fibrin gels [42]. The results on the 

kinetics of vascular cord formation revealed that intermediate stiffness facilitated rapid 
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vascular cord formation. Flexible and rigid gels showed a limited and unstable vascular 

cord network [42].  

 

Capillary morphogenesis by ECM density has been investigated by Ghajar et al. 

and Kniazeva et al. [51, 52]. They conducted an experiment to examine how HUVECs 

coated on micro-beads behave in different densities of fibrin gels. Both studies have 

revealed that increasing the density reduced capillary network formation. Ghajar et al. 

have concluded that the restriction of diffusion results in a reduced capillary network [51], 

whereas Kniazeva et al. have suggested that actin-mediated tractional forces regulate 

network formation [52]. These studies indicate that the mechanical property of ECM 

regulates capillary morphogenesis [51, 52]. 

 

 

1.3.2 Mechanical Properties of a 3D Gel in Vasculogenesis 

In addition to cord formation and capillary morphogenesis, vascular lumen 

formation in a 3D gel under mechanical strain has been examined [34, 53-56]. Sieminski 

et al. seeded HUVECs and human blood outgrowth endothelial cells (BOECs) in floating 

and constrained collagen gels [53]. In this study, the elongation of network formation, 

lumen area and actin stress formation were shown to depend on cell type, collagen 

concentration and contractility of the gel. BOECs showed less lumen size than HUVECs 

while exerting more traction than HUVECs. In addition, larger lumen area in a rigid gel 

and an elongated network in a soft gel were observed. Together, these results suggest that 

the stiffness of the matrix and cell generated tension may play an important role in 

capillary morphogenesis [53]. 

 

Moreover, Yamamura et al. have investigated that bovine pulmonary 

microvascular endothelial cells (BPMECs) are seeded at collagen gels with varying 

mechanical properties [54]. In the flexible gel, a dense and thin network of small 

vacuoles was formed. In the rigid gel, larger lumens produced by multiple cells were 

formed. Because the cells need more degrading activity to penetrate the rigid gel, this 
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degrading activity may contribute to decreased the migratory activity and the formation 

of cell aggregates. In the flexible gel, on the other hand, the cell shifts to migratory 

activity rather than vascular morphogenesis so that small vacuoles are formed [54].  

 

Hanjaya-Putra et al. have further demonstrated that in vitro tubulogenesis of EPC 

is regulated by both soluble cues and mechanical cues [34]. EPCs were cultured at three 

different Young’s moduli, rigid, firm and yielding, of hyaluronic acid hydrogels and 

induced capillary morphogenesis by vascular endothelial growth factor (VEGF). In the 

yielding substrate, mean tube length, tube area and tube thickness were increased and 

open lumens were formed. These vascularization results were not shown in the rigid 

substrate. The results of yielding substrate suggest reduced tension between cells and 

ECM is sufficient to activate signals of vascular development. EPCs cultured on the rigid 

substrate, on the other hand, have to shift to producing MMPs to overcome ECM 

mechanical barriers instead of migration and morphogenesis [34].  

 

 

 

Table 1.1 Summary of mechanical properties and vasculogenesis 

Cell type Stiffness 
Morphogenetic 

type 
Features Ref. 

BAEC 

Collagen gel 

Young’s modulus 

(200 ~ 10,000 Pa) 

Capillary cord  
structure 

Compliant substrate promotes  
the cord structure 

[50] 

HUVEC 

Fibrin gel 

concentration 

(1, 2, 3 mg/ml) 

Capillary cord  
structure 

Intermediate rigidity promotes  
the cord structure 

[42] 

HUVEC 

Fibronogen 

concentration 

(2.5, 5, 10 mg/ml) 

Capillary  

network 

Increasing density reduces the  

capillary network 
[51] 

HUVEC, 
HBOEC 

Floating and constrained 

collagen gel 

(1.5, 3 mg/ml) 

Lumen  
formation 

Shorter and wider lumens in a  

constrained gel than  

a floating gel. 

[53] 

BPMEC 

Collagen gel 

relaxation modulus 

(5000 ~ 23,000 Pa) 

Lumen  
formation 

Larger lumen is shown in a  
rigid gel 

[54] 

EPC 

Hyaluronic acid-gelatin 

Young’s modulus 

(10, 75, 650 Pa) 

Lumen  
formation 

Decreased substrate stiffness  
extends intracellular vacuoles 

[34] 

ECFC 

Collagen gel 

Shear storage modulus 

(24, 136, 300 Pa) 

Lumen  
formation 

Increased stiffness decreases  
vacuole area 

[55] 

ECFC 

Collagen gel 

concentration 

(0.5, 1.5, 2.5, 3.5 mg/ml) 

Lumen  
formation 

Higher concentration shows  

decreased density and increased tot

al vessel area 

[56] 
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Recently, Bailey et al. and Crister et al. seeded ECFCs in a different 

concentration of type I collagen gels and investigated the capillary morphogenesis in 

vitro and in vivo, respectively [55, 56]. Bailey et al. cultured ECFCs in both monomer 

and oligomer collagen gels with different collagen concentrations. Oligomer collagen 

showed the greatest vacuole density, similar vacuole areas and the greatest total vacuole 

area as compared to monomer collagen. At both oligomers and monomers, increased 

collagen concentration which increased the stiffness of the gel has decreased vacuole area 

due to spatial constraints imposed by increasing fibril density [55]. Crister et al. 

conducted the experiment of different mechanical properties of cellularized collagen 

matrices by ECFCs implanted into the flank of immunodeficient mice and investigated 

the capillary network formation. The density of ECFC-derived vessels was decreased, but 

total vessel area was increased in matrices with higher collagen concentration [56]. Taken 

together, these results support the notion that the stiffness of the matrix is a critical 

parameter to regulate angiogenesis and vasculogenesis of ECFCs.  

 

 

1.4 Molecular Mechanisms of in vitro Vasculogenesis 

EC lumen formation is an important event that occurs during vascular 

 

 

 

Figure.1.4 Model of vascular lumen formation and signal pathway [58] 
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morphogenesis. Many studies have attempted to define the pathway in vascular 

morphogenesis by ECs in 3D ECM environments, but it is still controversial. The first 

suggested model of vascular lumen formation is the pinocytic mechanism, which has 

been found to occur during intracellular vacuole formation in vitro models. Vacuoles arise 

from an invagination of the plasma membrane and subsequently coalesce to form a lumen 

(Fig. 1.4) [43, 57-58]. This process has been known to depend upon α2β1integrin, Cdc42, 

Rac1, and MT1-MMP that are needed for intracellular vacuoles formation by the 

pinocytic uptake of the plasma membrane mechanism [59].  

 

 

1.4.1 Integrins in Vasculogenesis 

Interaction between ECs and the ECM are required to form a vascular tube. 

Integrins are heterodimeric adhesion receptors and they have been recognized as a 

mediator of cell-matrix interactions [60, 61]. Nine integrins have been found to bind to 

collagen, laminins and fibronectins. Among these, α1β1 and α2β1 integrins are known as 

collagen-binding integrins that participate in vascular development [62]. Evidence for the 

participation of integrins in vascular lumen formation was proved by the inhibition of β1 

and α2, which results the interference in capillary formation. On top of that, the loss of 

the β1 integrin has influenced the disruption of cell polarization and lumen formation as 

well as the decreased of Par3 protein levels [43, 60]. Also, treating cells with anti-α2β1 

antibody in order to activate the integrins has resulted in an increase of lumen formation 

[63].  

 

 

1.4.2 Rho GTPases in Vasculogenesis 

Rho GTPases, a member of the Ras superfamily of GTPases, include RhoA, Rac 

and Cdc42. These Rho GTPases regulate the cytoskeleton and connect the cytoskeleton 

and integrins [64]. Rho GTPases have prominent roles in various aspects of intracellular 

activities such as cell morphology, migration, contraction and secretory activity. Rho 

GTPases are bi-molecular switches by cycling between GDP and GTP states. Rho switch 

is regulated by activators which are named GEFs (Guanine nucleotide-exchange factors) 
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and suppressors which are GAPs (GTPase-activating proteins). GEFs exchange GDP to 

GTP and that leads to activation, whereas GAPs hydrolyse GTP to GDP and suppress 

activity [65].  

 

Cdc42 is an important molecule of its function in actin polymerization and 

filopodia formation. Recently, Cdc42 has been known to regulate ECM remodeling in a 

3D culture system. Depletion of Cdc42 in fibroblasts demonstrated reduced focal 

adhesions and a reduction in production of MMP that indicate Cdc42 is essential in ECM 

remodeling [66]. Rho and Cdc42 play an interacting role between cell-matrix by cellular 

morphology and matrix remodeling in a 3D culture [67]. 

 

Downstream proteins of the integrin signal pathway, Cdc42 and Rac1 are 

members of the Rho GTPase family that are also involved in vascular development [59]. 

Rho signaling pathways are also involved in various physiological functions in the 

maintenance of vascular homeostasis, such as vasoconstriction, hypertension, 

inflammation, and wound healing [68].  

 

However, Cdc42 and Rac1 participated in vascular lumen formation. During the 

formation process, the activity of Cdc42 and Rac1 increases 2 to 2.5 folds [69] and 

Cdc42- specific guanine exchange factors, FGD4 and frabin, are also up-regulated two 

folds [59]. Additionally, it has been well demonstrated that inhibition of Rac1 and Cdc42 

also inhibits the lumen formation [44]. Various downstream effectors of Rac1 and Cdc42 

are activated as well. Pak2, Pak4, cell polarity proteins, which are Par3 and Par6, as well 

as PKC have been required for lumen and tube formation [69]. Later, PKCε, Src, Yes, B-

Raf, C-Raf and ERK1/2 also have been reported to be involved into EC lumen formation 

in 3D collagen gel [70]. Moreover, junction adhesion molecules Jam-B and Jam-C have 

been shown to be involved in lumen formation as proved by experiments utilizing siRNA 

and dominant-negative mutants (Fig.1.5) [71]. 
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Figure 1.5 Signal pathway of vacuole and lumen formation [59, 69-71] 

 

Many in vitro studies described the process of lumen formation. In 2006, the first 

in vivo research of vascular tube morphogenesis was conducted with zebrafish and 

showed how endothelial tubes assembled in vivo. The experiment was conducted by 

quantum dot injection and showed the transfer of quantum dots from the dorsal aorta to 

intersegmental ECs through vacuole uptake. The result indicates that intracellular and 

intercellular fusion of vacuoles drive the vascular lumen formation by exocytosis [58]. 

Later, the β1 integrin and Par3 protein have been shown in the experiment conducted 

upon mice that they are required for endothelial polarity and lumen formation. Using 

gene knockout mice, ablation and blockade of β1 integrin caused a loss of cell polarity 

and the inhibition of lumen formation. The report has suggested that β1 integrin 

activation leads the activation and localization of Claudin-5, PECAM-1, VE-cdherin, and 

CD99 which are needed for lumen formation [60].  

 

Although involvement of Cdc42 and Rac1 in vascular lumen formation has been 

proved by evidence, the role of RhoA is still controversial. Another possible mechanism 
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for vascular lumen formation has suggested that RhoA and Rho-associated protein kinase 

(ROCK) under VEGF signaling are involved with the evidence from the studies of 

intercellular junctions of blood vessels in the mice aorta [72]. Briefly, ECs adhere to each 

other and then separate by CD34-sialomuscins which is localized by VE-cadherin. After 

that, Moesin localizes F-actin at the apical surface of the ECs. In a sequence, VEGF-A 

activates ROCK and makes non-muscle Myosin II. This enables ECs to separate apical 

EC surfaces and lead to EC shape change which causes vascular lumen formation. This 

report has suggested that lumen formation occurs via intercellularly [72]. However, the 

involvement of RhoA has been contradicted by other findings. Bayless et al., have 

provided the evidence that EC vacuole and lumen formation by pinocytosis is regulated 

by Rac1 and Cdc42, but RhoA has a minimal role. This has been proved by inhibitors; 

Toxin B, which blocked all of Rho GTPases, inhibited lumen formation but C3 

transferase, which blocked only RhoA, did not interfere with lumen formation [44].  

 

Recent studies have shown that cerebral cavernous malformation 2 (CCM2) 

affects Rho and Rap GTPases. CCM2 is not required in vasculogenesis but is needed in 

angiogenesis for the endothelium during mouse embryogenesis. CCM2 regulates lumen 

formation via the actin cytoskeleton, and the loss of functional CCM2 has been shown to 

lead to impaired lumen formation, increased actin stress fibers, and decreased barrier 

function, which is an indication of RhoA activation [73]. Moreover, Ras-interaction 

protein (RASIP 1) has been known to bind to the RhoA GTPase-activating protein 

(Arhgap29) and suppress RhoA activity. Loss of RASIP 1 or Arhgap29 results in an 

increase of RhoA activation, stress fiber and actomyosin so that the lumen formation is 

blocked. In addition, defects of RASIP1 increase RhoA/ROCK/myosin II activity by the 

blockade of Cdc42 and Rac1 signaling [74]. 

 

 

1.4.3 The Role of MT1-MMP in Vascuologenesis 

The role of MT1-MMP has been investigated in vascular morphogenesis. It 

creates vascular guidance tunnels in the 3D collagen matrix. The modification of ECM 
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environments by ECs to support cellular functions is important in vascular 

morphogenesis. MMP is critical in all processes of angiogenesis: initiation, invasion and 

lumen formation of ECs. It is necessary to control vascular morphogenesis for re-growing 

and remodeling, for pericyte recruitment from the surrounding ECM, for basement 

membrane rearrangement and for vascular maturation and stabilization [28]. 

 

Also, tissue inhibitor of metalloproteinases (TIMPs) such as TIMP-2, TIMP-3 

and TIMP-4 inhibit EC vacuole and lumen formation. In addition to the result, RNA 

knockdown of MT1-MMP markedly inhibits vacuole and lumen formation. However, 

soluble MMPs are not involved in vacuole and lumen formation. Only MMP-1 and 

MMP-10 appear in the regression of tube network [28].  

 

 

1.4.4 Recent Findings of Molecular Pathways in Vasculogenesis 

Recent in vivo experiments by zebrafish embryos have suggested that three 

distinct mechanisms of tube morphogenesis such as budding, cord hollowing, and cell 

hollowing coexist [75]. Moreover, a function of VEGF-driven angiogenesis is seen in the 

mice model. The co-activation of VEGF and Cdc42 improves capillary morphogenesis 

and lumen formation both in vivo and in vitro [76]. These reports have suggested that 

there are various pathways which depend upon various parameters, such as cell or matrix 

type. Another recent proposed mechanism of vasculogenesis formulated through the 

study of zebrafish has claimed selective sprouting and ECs migration toward erythrocytes 

is the pathway for angiogenesis. This model was supported by selective sprouting during 

the lumen formation. Ventral ECs migrated toward erythrocytes by VEGF-C via 

phosphoinositide 3-kinase and ephrin-B4 to surround the cell. Then, cells which formed 

lumens were retained by VEGF-A, which induced phospholipase-cγ and ephrin-B2 [77]. 

These multiple possible mechanisms suggest that we only know the small portion of 

lumen formation signal pathway and that further analysis is required. 
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1.5 FRET Microscopy 

For the detailed explanation of a protein function in living cells using fluorescent 

proteins, three methods have been developed to identify the dynamics of protein 

interaction: fluorescence resonance energy transfer (FRET), fluorescence correlation 

spectroscopy and complementation of split fluorescent proteins [78]. Among these 

techniques, FRET has been the most commonly used to investigate the function of 

protein in living cells. The principle of FRET is two fluorophores are fused as a donor 

and acceptor. When activation of a probe allows two fluorophores close to shorter than 10 

nm in proximity by the conformational changes, a donor fluorophore can transmit energy 

into an acceptor fluorophore. This causes the acceptor fluorophore to fluoresce its 

emission spectrum [78]. 

 

 

1.5.1 Rho GTPases Biosensors based on FRET 

To understand spatiotemporal activity of Rho GTPases, Dr. Matsuda’s group has 

developed the FRET probes of Rho GTPases (Fig. 1.6) [79-81]. The probe consists of 

four domains: a donor (CFP), an acceptor (YFP), the GTPases and the GTP binding 

domains and are sequentially connected. Between domains, spacer is needed. Spacer 

consists of repeated sequences glycine (Gly) and serine (Ser). Gly is for flexible fording 

whereas Ser is for preventing aggregation. In the inactive state, GDP binds to GTPases so 

that CFP and YFP probes are placed remotely and fluorescent emission is exclusively 

from CFP. In the active state, GDP is changed to GTP, causing conformational changes in 

the probe that bring CFP and YFP to sufficient proximity of energy transfer. The 

measurement of YFP/CFP ratio corresponds to GTP/GDP ratio so that we can track 

changes in protein activity [79]. 

 

The Matsuda’s group has developed Rac1, Cdc42 [80] and RhoA [81] FRET-

based probes. Although GFP-based FRET probes are classified into intermolecular and 

intramolcular probes, Raichu-GTPases are intramolecular probes. By using Raichu-Rac1 

and Raichu-Cdc42 probes, spatiotemporal activity was investigated during cell migration.  
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Figure 1.6 Structure of FRET-based Cdc42 biosensor [79] 

 

The results showed that Rac1 was highly activated at the rear edge whereas 

Cdc42 was highly activated at the leading edge [80]. By including a RhoA probe, they 

also monitored spatiotemporal activity during cell division. Temporally, GTPases were 

highly activated in interphase but decreased during the mitotic phase. Spatially, RhoA 

activity was highly detected at cleavage furrow. Also, Rac1 was highly activated at the 

polar sides after telophase and Cdc42 was high at the membrane in cytokinesis [81]. 

These reports showed FRET-based probes can be used to visualize GTPases regulation in 

diverse aspects of cellular behaviors. 

 

 

1.5.2 Optical Setup of Microscopy 

To measure spatiotemporal protein interactions of a living cell in 3D culture, 

widefield and confocal microscopes have been utilized. Thus, appropriate optical setup of 

the experiment is also required to visualize fluorescent proteins. The appropriate 

microscope and objective are needed. The light source is a halogen or xenon lamp used 

for fluorescent images. Firstly, neutral density (ND) filters are used to reduce the intensity 

of excitation light. Three filters are needed: a CFP (donor) excitation filter, a CFP (donor) 

emission filter and an YFP (acceptor) emission filter. These filters are located at two 

wheels which enable filters to rapidly switch. The emission filter wheel is located next to 

CCD camera. 3D stack images can be acquired by the motorized stage with a controller 

(Fig. 1.7) [82]. 
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Figure 1.7 The outline of optical setup of the FRET microscope system [82] 

 

 

1.6 Thesis Objectives 

The objective of this dissertation is to elucidate the role of matrix stiffness in 

regulating the capillary morphogenesis. To be specific, the effect of altered matrix 

stiffness in Cdc42 activation and in vitro vacuole formation of ECFCs was examined. 

There are two specific goals in this dissertation.  

 

The first goal is to uncover the spatiotemporal activity of Cdc42, linking to 

matrix stiffness during early vacuole formation. In this regard, vacuole formation and 

Cdc42 activity of ECFCs was investigated under shear storage moduli of 150 Pa and 1 

kPa. To measure spatiotemporal Cdc42 activity, we used Cdc42 FRET-based probe which 

enables us to observe protein functions in a living cell.  

 



www.manaraa.com

19 

 

The second goal is to explore the contribution of the Cdc42 activation in the 

kinetics of vacuole formation and vacuole size. In order to assess the role of Cdc42 

activation, Cdc42 mutants were used. 

 

 

 

 

 



www.manaraa.com

20 

 

2. METHODS 

 

 

2.1 Cell Maintenance 

ECFCs, isolated from human umbilical cord blood, were obtained from Dr. 

Yoder (Indiana University School of Medicine, Indianapolis, IN) and cultured under 

previously described method [18]. Briefly, ECFCs were cultured in EGM-2 media (Lonza, 

Walkersville, MD) supplemented with 10% of defined FBS (Invitrogen, Carlsbad, CA) 

and 1.5% of antibiotic-antimycotic (Invitrogen, Carlsbad, CA), and maintained at 37°C 

and 5% CO2 in a humidified incubator. Prior to experiments, the cells were cultured in a 

T-75 tissue culture flask (Becton, Dickinson and Co., Franklin Lakes, NJ), coated with 50 

μg/ml of rat-tail collagen type I (BD Biosciences, Franklin Lakes, NJ), and passages 4 to 

9 were used for all experiments. 

 

 

2.2 DNA Plasmids and Transfection 

We used a FRET-based, cyan fluorescent protein (CFP)-yellow fluorescent 

protein (YFP) Cdc42 biosensor, a generous gift from Dr. Matsuda (Kyoto University, 

Japan). Its characteristics and specificity were well described [80]. As Cdc42 mutants, a 

constitutively-active Cdc42 (Cdc42-L61) and a dominant-negative Cdc42 (Cdc42-N17) 

were used. The DNA plasmids were transfected into the cells using a Neon transfection 

system (Invitrogen, Carlsbad, CA) following the manufacturer’s protocol. A single, 1000 

mV pulse with duration of 20 ms was found to be an optimal parameter for transfection.  
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Table 2.1 Summary of shear storage modulus of collagen matrices by the collagen 

polymerization composition. 
Approx. Conc. (mg/ml) Final Stiff. (Pa) Final Vol.(ml) HCl(ml) Collagen(ml) PBS(ml) NaOH(ml) CaCl2(ml) 

0.382551 10 0.5 0.357 0.03 0.05 0.05 0.013 

1.313373 100 0.5 0.283 0.104 0.05 0.05 0.013 

1.584185 150 0.5 0.262 0.126 0.05 0.05 0.013 

1.810423 200 0.5 0.244 0.144 0.05 0.05 0.013 

2.782277 500 0.5 0.167 0.221 0.05 0.05 0.013 

3.478689 800 0.5 0.111 0.276 0.05 0.05 0.013 

3.870521 1000 0.5 0.08 0.307 0.05 0.05 0.013 

 

 

2.3 Fabrication of Collagen Gel 

The collagen mixture was provided by Dr. Voytik-Harbin (Purdue University, 

West Lafayette, IN) and followed the preparation as previously described [39]. The 

mixture included porcine skin collagen (6.8 mg/ml), 0.01 N HCl, 10x PBS, 0.1 N NaOH 

and CaCl2 to achieve neutral pH. The stiffness of collagen gel was measured using a 

stress-controlled AR2000 rheometer (TA Instruments, New Castle, DE) [39]. The shear 

storage modulus (G′, stiffness) of 150 Pa was 1.58 mg/ml and that of 1 kPa was 3.87 

mg/ml (Fig 2.1, Table 2.1). To solidify the mixture, gel was incubated at 37°C and 5% 

CO2 for 30 min. 

 

 

Figure 2.1 The relationship between shear storage modulus and collagen quantity [39] 
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2.4 In vitro Early Vacuole Formation Model 

A small glass cylinder (Fisher Scientific, Pittsuburgh, PA) was placed on top of 

35 mm glass-bottom dish (MatTek Co, Ashland, MA). ECFCs transfected with Cdc42 

biosensors were mixed with collagen solution in the cylinder and incubated at 37°C and 5% 

CO2 for 30 min. In order to induce vacuole formation, we followed the published method 

[83, 84]. First, ECFCs were incubated overnight in EBM-2 media (Lonza, Walkersville, 

MD) containing 40 ng/ml of fibroblast growth factor (FGF-2, R&D systems, Minneapolis, 

MN) and reduced-serum II supplement (RS II, 1:250) to maintain the cell viability and 

prime the vacuole formation. At the time of experiments, media was replaced with fresh 

EBM-2 media supplemented with 200 ng/ml of stem cell factor (SCF), stromal cell-

derived factor-1α (SDF-1α), and interleukin-3 (IL-3) (R&D systems, Minneapolis, MN) 

to induce vacuole formation (Fig. 2.2) [83]. RS II was prepared by the published protocol 

(Fig. 2.3) [84]. 

 

 

 

 

 

 

Figure 2.2 Schematic diagram of experimental procedure 
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Figure 2.3 Flow chart of the preparation RS II [84] 

 

 

2.5 FRET Microscopy 

All images were obtained by using an automated fluorescence microscope 

(Nikon, Melville, NY) equipped with an electron-multiplying charge-coupled device 

(EMCCD) camera (Photometrix, Tucson, AZ), a filter wheel controller (Sutter, Novato, 

CA), and a perfect focus system (PFS; Nikon, Melville, NY). The following filter sets are 

used (Semrock, Rochester, NY): CFP excitation: 438 nm / 24nm (wavelength/ 

bandwidth); CFP emission: 483 nm / 32 nm; YFP (FRET) emission: 542 nm / 27 nm. 

Cells were illuminated with a 100 W Hg lamp through an ND64 (~1.5% transmittance) 

neutral density filter to minimize photobleaching. Time-lapse images were acquired at an 

interval of 1 h with a 40X (0.75 numerical aperture) objective. Z-stack images were 

acquired at 0.6 µm intervals. FRET images for Cdc42 activity were generated with NIS-

Elements software (Nikon, Melville, NY) by computing emission ratio of YFP/CFP for 

the individual cell. During imaging, the cells were maintained at 37°C using an air stream 

incubator (Nevtek, Williamsville, VA). 
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2.6 Image Processing 

Acquired images (512 x 512 pixels, 0.4μm/pixel) were analyzed by both NIS 

Elements software and ImageJ software (NIH, Bethesda, MD). In NIS Elements, selected 

images were background-subtracted. FRET images were displayed by the ratio of 

YFP/CFP with a pseudo-colored scale. Z-stack images were used to generate 3D-

projection images. ImageJ software was used to display pseudo-colored FRET images 

[85]. First, both CFP and YFP images were background-subtracted by the rolling ball 

algorithm. Both images were aligned pixel to pixel and changed to 32 bit version. Smooth 

filter was applied to reduce the noise and threshold adjustment was carried out to 

eliminate artifacts by the noise. Corresponding pixels in the aligned CFP and YFP images 

were computed to generate YFP/CFP ratio images and a pseudo-colored scale was 

generated by Blue_Green_Red lookup table (Fig. 2.3) [85]. Hot color indicates higher 

activation of Cdc42 whereas cold color lower activation. 

 

 

 

 

Processing Step ImageJ Command Outcome 

Select ROI to be 
analyzed and  

crop the images 

Edit>Selection>Specify images 
>Crop 

CFP     YFP 

  
 

Background  
correction 

Process>Subtract background 
(Rolling ball radius) 

   

Registration 
Plugins>Registration> 

MultistackReg 

  
32-Bit conversion Image>Type (32 bit) 

Smooth filter Process>Smooth 

Threshold  
(only YFP) 

Image>Adjust>Threshold 
(Default, B&W,  

Dark background) 
  

Ratio YFP/CFP Plugins>Ratio plus 

 

LUT assignment 
Plugins>NucMed>Lookup  
Tables (Blue_Green_Red) 

 

Range adjustment 
Image>Adjust 

>Brightness/Contrast 

Preparation image
 for presentation 

Image>Type (RGB color) 

Figure 2.4 The procedure of FRET ratio image generation by using the ImageJ software 

[85] 
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2.7 Data Analysis 

Time courses of Cdc42 activity was quantified with the emission ratio of 

YFP/CFP. The emission ratios were averaged over the whole cell and were normalized to 

time point 0 h. The spatial analysis of Cdc42 activity was conducted by ImageJ software. 

A line was drawn on the body of cell including vacuoles. The plot profile represents the 

FRET intensity along the line [86]. The kinetics of vacuole formation was determined by 

the time point when vacuole was formed. DIC images were used to measure the vacuole 

area. For statistical analysis, outliers were deleted based on the Chauvenet’s criterion 

using the MATLAB program (Mathworks, Natick, MA).  

 

 

2.8 Statistical Analysis 

Data were presented as the mean ± standard error of the mean (SEM). In order to 

verify the statistical significance, one-way ANOVA was applied to the time course of 

Cdc42 activity and unpaired t-test was used for vacuole area analysis using Prism 5 

software (Graphpad Software, La Jolla, CA). P-value less than 0.05 was considered as a 

significant difference. 
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3. RESULTS 

 

 

3.1 Time-Lapse Imaging of ECFC Vacuole Formation in 3D Collagen Matrices 

A significant body of evidence has provided the role of Cdc42 and collagen gel 

in vacuole formation, but little is known about the spatiotemporal activity of Cdc42 

during vacuole formation at the subcellular resolution. To examine the activity of Cdc42 

during early vacuole formation, ECFCs, transfected with Cdc42 FRET-based biosensor, 

were seeded at a density of 1 x 10
7
 cells/ml in 3D collagen matrices with two different 

shear storage moduli. For this study we used two stiffness values, 150 Pa and 1 kPa.  

 

 

Figure 3.1 Representative images of vacuole forming cells. (A) DIC, (B) YFP, (C) 

YFP/CFP emission ratio image, (D) 3D-projection image (E) z-stack orthogonal images. 

White arrowheads indicate vacuoles. Scale bar = 10 μm
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To study Cdc42 activation during early vacuole formation, we modified previous 

method [83, 84]. Instead of adding FGF-2 into collagen matrices, we added 40 ng/ml of 

FGF-2 into EBM-2 media and incubated overnight with 40 ng/ml of FGF-2 to up-

regulate hematopoietic cytokine receptors. In our vasculogenesis model, vacuoles were 

formed within 6 h and they were enlarged and coalesced (Fig. 3.1). The occurrence of 

vacuole indicates that our modified assay is suitable to study early vacuole formation. 

More importantly, we observed that high Cdc42 activation occurred at vacuole sites, 

suggesting the involvement of Cdc42 in early vacuole formation. 

 

 

3.2 Cdc42 is Activated at Vacuole Sites 

We examined the localization of Cdc42 during vacuole formation. Previous 

studies have provided the evidence of Rho GTPases localization during migration [86, 87] 

and neurite extension [88]. Here, we demonstrated that Cdc42 is localized at vacuole sites. 

The lateral view of Cdc42 localization showed that Cdc42 is consistently activated along 

the z-levels (Fig 3.1). In addition, FRET ratio profile along the line across the vacuole 

and cell body was analyzed. In both soft and rigid matrices, high activation of Cdc42 was 

observed adjacent to vacuole sites (Fig. 3.2). The localization of Cdc42 near vacuole sites 

provides the evidence of its importance in vacuole formation. 
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Figure 3.2 Plot profile of Cdc42 activity along the line on the cell body. The graph shows 

that Cdc42 activation is highly activated in both (A) soft (150 Pa) matrices and (B) rigid 

(1 kPa) matrices. Scale bar = 10 μm 

 

 

3.3 Cdc42 Activity is Increased in Soft Matrices during Early Vacuole Formation 

It has been well established that Cdc42 is associated with capillary 

morphogenesis in collagen gel matrix [44, 59], and plays an important role in 

mechanotransduction [67, 89]. To determine the role of the stiffness of matrix on Cdc42 

activity during early vacuole formation, we transfected a Cdc42 biosensor into ECFCs 

and measured Cdc42 activity near vacuole sites for 9 h (Fig 3.3). In soft (150 Pa) 

matrices, Cdc42 activity was increased (12.37 %) rapidly until 3 h (Fig 3.4). However, in 

rigid (1 kPa) matrices, significant Cdc42 activity was not observed during vacuole 

formation (Fig. 3.4). This result suggests that stiffness of collagen matrices are involved 

in Cdc42 activation during early vacuole formation.  

 

  



www.manaraa.com

29 

 

 

                                                     

F
ig

u
re

 3
.3

 T
im

e-
la

p
se

 i
m

ag
es

 o
f 

E
C

F
C

s 
d
u
ri

n
g

 e
ar

ly
 v

ac
u
o
le

 f
o
rm

at
io

n
. 

(A
) 

V
ac

u
o
le

 i
s 

fo
rm

ed
 a

t 
1
 h

 

af
te

r 
cy

to
k
in

es
 t

re
at

m
en

t 
in

 s
o
ft

 (
1
5
0
 P

a)
 m

at
ri

ce
s 

an
d
 C

d
c4

2
 i

s 
h
ig

h
ly

 a
ct

iv
at

ed
 n

ea
r 

v
ac

u
o
le

 a
re

a.
 (

B
) 

V
ac

u
o
le

 i
s 

fo
rm

ed
 a

t 
2

 h
 a

ft
er

 c
y
to

k
in

es
 t

re
at

m
en

t 
in

 r
ig

id
 (

1
 k

P
a)

 m
at

ri
ce

s.
 R

ig
h
t-

b
o
tt

o
m

 e
n
la

rg
ed

 i
m

ag
e 

sh
o
w

s 
h
ig

h
 C

d
c4

2
 a

ct
iv

at
io

n
 n

ea
r 

v
ac

u
o
le

 a
re

a.
 C

o
lo

r 
b
ar

s 
re

p
re

se
n
t 

em
is

si
o
n
 r

at
io

 o
f 

Y
F

P
/C

F
P

 o
f 

th
e 

b
io

se
n
so

r,
 a

n
 i

n
d

ex
 o

f 
C

d
c4

2
 a

ct
iv

at
io

n
. 

Im
ag

es
 o

f 
Y

F
P

/C
F

P
 a

re
 s

ca
le

d
 a

cc
o
rd

in
g
 t

o
 t

h
e 

co
rr

es
p
o

n
d
in

g
 

co
lo

r 
b
ar

s.
 

T
h
e 

w
h
it

e 
b
o
x
es

 
ar

e 
cr

o
p
p
ed

 
an

d
 

en
la

rg
ed

 
fo

r 
b
et

te
r 

v
is

u
al

iz
at

io
n
. 

W
h
it

e 
an

d
 

b
la

ck
 

ar
ro

w
h

ea
d
s 

in
d
ic

at
e 

v
ac

u
o
le

s 
in

 a
ll

 f
ig

u
re

s.
 S

ca
le

 b
ar

 =
 1

0
 μ

m
 



www.manaraa.com

30 

 

 

Figure 3.4 Time courses of Cdc42 activation during early vacuole formation. Cdc42 is 

highly activated at 3 h in soft (150 Pa) matrices during early vacuole formation. Time 

courses of YFP/CFP emission ratio are averaged over the whole cells and normalized to 

time point 0 h. Data represent mean ± SEM. 

 

 

3.4 Vacuoles were Formed Earlier in Soft Matrices than in Rigid Matrices 

To determine the role of matrix stiffness on the kinetics of vacuole formation, we 

quantified the number of cells that made vacuoles for 6 h. This is the first detailed report 

of how matrix stiffness contributes to the kinetics of early vacuole formation. Soft 

matrices induced earlier vacuole formation (62.5 % within 3 h), while rigid matrices led 

 

 

Figure 3.5 The kinetics of early vacuole formation. Vacuoles formed earlier in soft 

matrices than rigid matrices. 
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to slower vacuole formation (43.48 % at 4 h) (Fig. 3.5). These results suggest that the 

stiffness of matrix affects the kinetics of early vacuole formation. 

 

 

3.5 Vacuole Area is not Dependent on Matrix Stiffness 

Previous reports have demonstrated that increasing the stiffness of 3D collagen 

matrices decreases the vacuole area of ECs [34, 55]. The results revealed that average 

vacuole area in soft matrices is larger (106.1 ± 7.787 μm
2
) than that (100.3 ± 7.809 μm

2
) 

in rigid matrices (Fig. 3.6). These results are consistent with previous reports of Hanjaya-

Putra et al. [34] and Bailey et al. [55] demonstrating that reduced stiffness increases 

vacuole area. However, our results in two different matrices did not show a significant 

difference.  

 

 

 

 

 

Figure 3.6 The effect of matrix stiffness on vacuole area. Vacuole area is not dependent 

on matrix stiffness. Soft matrices (n = 46, n = cells) and rigid matrices (n = 49) do not 

show a significant difference. Data represent mean ± SEM. 
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3.6 Early Vacuole Formation is Mediated in Part by Cdc42 

To further examine the role of Cdc42 activity in early vacuole formation, we co-

transfected ECFCs with GFP-actin and one of Cdc42 mutants, a constitutively active 

Cdc42-L61 and a dominant negative Cdc42-N17. The control was only transfected with a 

GFP-actin. Only transfected cells (confirmed by GFP) were quantified after 4 h of 

hematopoietic cytokines treatment (Fig. 3.7). The results showed that 15 % of ECFCs 

formed vacuoles in control (14.77 ± 0.03 %, n = 19, n = the number of experiments) and 

Cdc42-L61 significantly increased vacuole formation (24.28 ± 0.027 %, n = 20). 

Although less vacuoles (10.86 ± 0.027 %, n = 25) were formed in Cdc42-N17-transfected 

ECFCs, dominant negative Cdc42 failed to completely block the vacuole formation (Fig. 

3.8). These results suggest that other factors, independent of Cdc42, may also participate 

in regulating ECFC vacuole formation. 

 

 

 

 

 

 

 

Figure 3.7 Expression of GFP-actin by mutants transfected ECFCs. (A) Cdc42-L61 

promoted vacuole formation while transfection with (B) Cdc42-N17 inhibited vacuole 

formation. Scale bar = 10 μm 
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Figure 3.8 The effect of Cdc42 on vacuole formation. Early vacuole formation is 

mediated in part by Cdc42. (A) Treatment of Cdc42-L61 (n = 20, n = experiments) 

significantly increases early vacuole formation as compared to control (n = 19), whereas 

Cdc42-N17 (n = 25) decreases it. (B) Representative images of ECFCs transfected with 

Cdc42-L61 and Cdc42-N17. White arrowheads indicate vacuoles. *P < 0.05, Scale bar = 

50 μm 
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4. DISCUSSION 

 

 

Vascularization, driven by EPCs, is essential for tissue survival and development 

of a functional bioengineering graft. It is known that ECFCs, a subset of EPCs, have a 

great therapeutic potential in repair of damaged tissues [15, 18, 56]. While substantial 

progress has been made to uncover the mechanism of vascularization using ECFCs, it 

remains elusive how individual ECFCs respond to the rigidity of the matrix spatially and 

temporally to regulate vacuole formation.  

 

Previous works have demonstrated a role of cell-matrix interaction in capillary 

morphogenesis [34, 42, 50-56]. ECs form capillary cord sprouting in 2D and 3D 

interstitial gels, while hollowing of individual cells is shown in 3D gels [28, 40]. This 

hollowing is known to generate vacuoles in the cytoplasm through the pinocytic process. 

Vacuoles then coalesce and connect to form lumen with adjacent cells [57, 58]. It has 

been shown that the process of capillary morphogenesis in 3D model depends on the 

matrix-integrin-cytoskeleton signaling axis [28]. This axis has demonstrated the 

involvement of Rho family GTPases such as Rac1 and Cdc42, and MT1-MMP in lumen 

formation [59]. Inhibition of Cdc42 and Rac1 decreases lumen formation, suggesting a 

significant role of Rho family GTPases in capillary morphogenesis [44]. Thus, it is 

obvious that Cdc42 is involved in both mechanotransduction via ECM and the capillary 

morphogenesis pathway. Although Cdc42 is obviously involved in vacuole formation in 

3D matrices, it is not known whether Cdc42 activity is altered by the stiffness of matrix 

(Fig. 4.1). 
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Figure 4.1 Schematic diagram illustrating the effect of collagen stiffness on Cdc42 

activation and vacuole formation 

 

Recent reports by Bailey et al. and Hanjaya-Putra et al. have described the 

different responses of ECFC in vacuole formation to stiffness [34, 55]. Bailey et al. have 

reported that increasing collagen concentration alters the stiffness of matrix and changes 

the vascular lumen formation of ECFCs [55]. Similarly, Hanjaya-Putra et al. have shown 

that vascular lumen formation was decreased in a rigid matrix, suggesting that the 

reduction of tension may trigger a signaling cascade which leads to vascular lumen 

formation [34]. Our study extends the findings of Bailey et al. and Hanjaya-Putra et al. 

that the stiffness of matrix alters ECFC vacuole formation in vitro.  

 

To examine how the stiffness of matrix alters Cdc42 activity and vacuole 

formation, we transfected ECFCs with a FRET-based Cdc42 biosensor, and seeded them 

into collagen matrices with different shear storage moduli (150 Pa and 1 kPa). After 

hematopoietic cytokines were applied, Cdc42 was highly activated near the vacuole sites 

of ECFCs. In addition, Cdc42 activation preceded the vacuole formation. These results 

are consistent with a previous report demonstrating that Cdc42 is involved in the 

initiation of vacuole formation while Rac1 is involved in the enlargement and remodeling 

of vacuoles [44]. Moreover, Cdc42 was differentially regulated in a 3D matrix depending 

on its stiffness. In soft (150 Pa) matrices, Cdc42 activity steadily increased until 3 h and 

then started to decrease to the basal activity. However, in rigid (1 kPa) matrices, Cdc42 

activity was not significantly altered during vacuole formation although its initial 

activation level was higher than that in soft matrices. There are several possible 

explanations. In rigid matrices, initial Cdc42 activity may be strong enough to induce 

vacuole formation. Another possible explanation is that increased matrix stiffness may 

activate RhoA thereby inhibiting Cdc42. Alternatively, increased collagen concentration 

increases collagen cross link fibril density. Thus, cytokines might diffuse slowly so that 

Cdc42 activation is hindered.  
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To investigate the kinetics of early vacuole formation, we compared the time 

point of early vacuole formation between soft and rigid collagen matrices. By analyzing 

the pattern of early vacuole formation, we observed that vacuoles formed earlier in soft 

matrices than rigid matrices. Most of the vacuoles were formed at 2 to 3 h in soft matrices, 

while they were formed at 3 to 4 h in rigid matrices. These data suggest one hour shifts of 

vacuole formation in rigid collagen matrices and soft matrices cause faster vacuole 

formation than that of rigid stiffness. Together with Cdc42 activity data, these results 

suggest that an increase in Cdc42 activity stimulates vacuole formation and these 

responses are dependent on matrix stiffness.  

 

Next, we postulated that if matrix stiffness regulated Cdc42 activity and initiation 

of vacuole formation, it would alter the morphology of the vacuoles. We observed that 

average vacuole area was 106.1 μm
2
 and 100.3 μm

2
 in soft and rigid matrices, 

respectively. Although mean vacuole area in soft matrices was 6% larger than that in rigid 

matrices, they did not show a significant difference. There is a discrepancy in previous 

reports on lumen size and matrix stiffness. Increased matrix stiffness has shown to 

decrease endothelial lumen formation and average lumen area [34, 55]. Opposite results 

have also been reported that vacuole area is increased in rigid matrices [53, 54]. These 

reports have suggested that an increase of stiffness activates RhoA, which facilitates 

angiogenesis and capillary branching [90]. Also, it has been demonstrated that tumor 

tissues which are stiffer than normal tissues developed a large vascular lumen [53]. This 

discrepancy may be due to different endothelial source, matrix composition, and the 

measurement methods.  

 

To further investigate the role of Cdc42 in early vacuole formation, we used two 

Cdc42 mutants: constitutively active Cdc42 (Cdc42-L61) and dominant negative Cdc42 

(Cdc42-N19). Our results demonstrated that Cdc42-L61 promotes vacuole formation, 

while Cdc42-N19 inhibits it. This result is consisted with previous study using Cdc42 

siRNA that Cdc42 inhibition suppressed lumen formation of ECs in 3D collagen matrices 

[69]. In our study, Cdc42-N17 did not completely suppress vacuole formation. This could 
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be due to drawbacks of using dominant mutants of Rho GTPases [91]. The principle of 

dominant mutant is threonine residue at 17th amino acid is changed to asparagine and the 

mutants binds to GEFs with high affinity to make dead-ends [92]. The result of inhibition, 

however, may be distorted by the expression level of the mutant and interaction with 

other Rho family GTPases [91].  

 

In conclusion, we demonstrated that the stiffness of collagen matrices alters 

Cdc42 activity and regulates early vacuole formation of ECFCs. Local Cdc42 activation 

induces vacuole formation and its activity is associated with dynamics of vacuole 

formation. The results presented here suggest that mechanical balance between ECFCs 

and matrices is an important parameter to regulate vascularization. Future studies will 

address how Rac1 or Cdc42 interacts with matrix metalloproteinases such as MT1-MMP 

in response to matrix stiffness. 
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